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Date

Change Description

2017-09-20

FortiPortal 4.1.0 initial release

2017-10-03

Updates to the “Installation using VMware” chapter (now titled “FortiPortal Installation”) and the
"Upgrading FortiPortal Software" chapter

2017-10-6

Updates to the “Installation using VMware” chapter
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FortiPortal Overview
FortiPortal enables a Managed Security Service Provider (MSSP) to operate a cloud-based hosted security
management and log retention service. The service provides the MSSP end-customers with centralized reporting,
traffic analysis, configuration management, and log retention without the need for the end customer to invest in
additional hardware and software.

Key Features
FortiPortal provides the following features:
l

dashboard widgets for system and log status

l

log viewer with filters

l

drill-down analysis of user and network activity

l

report generator (with customization options)

l

wireless network status

l

device management

l

policy management

l

Remote authentication using FortiAuthenticator

FortiPortal supports the following languages: Romanian, French, Portuguese, Spanish and English.

Special Characters
In releases prior to 2.40, you could include some special characters (quote and backslash) in controller names.
For example, the following name would be valid:
Name'1/3
However, In release 2.4.0 and later, you must not use these characters. Prior to upgrading to release 2.4.0, you
must remove these special characters from existing names.
In release 2.4.0, if an entry has a name containing a special character, you will not be able to edit the entry (but
you can delete it).

Components
The end-customer's FortiGate devices are managed by one or more FortiManagers. Optionally, logs from the
FortiGate devices can be gathered by one or more FortiAnalyzers.
In the FortiPortal, the Collectors collect logs from the FortiAnalyzer (or the FortiGate devices directly) and store
the logs in Collector databases. The Portal aggregates the logs into a central database, and performs security
analytics on the logs. The Portal provides an administrative web interface (for the service provider administrative
staff) and a customer web interface (for the MSSP's customers).

FortiPortal 4.1.0 Release Notes
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The following figure illustrates the FortiPortal components and a typical customer network.

The FortiPortal solution includes the following components:

1. Collector: virtual appliance:
l
Manages logs sent from the FortiGate devices
l
The FortiPortal may include more than one Collector
2. Collector DB: MySQL database:
l
Physical or virtual server provided by the Service Provider
l

Collector stores the logs in this database

l
The FortiPortal may include more than one Collector DB
3. Portal: virtual appliance:
l
Provides the service provider web interface and the customer web interface.
l
l

Uses the FortiManager API to manage Devices, Objects and Policies
The FortiPortal includes only one Portal (however, the portal may consist of multiple VM instances for
redundancy and/or scalability)

4. Portal DB: MySQL database:
l
Physical or virtual server provided by the Service Provider

9

l

Portal aggregates the logs into this database

l

The FortiPortal includes only one Portal Database
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The customer web interface enables each end customer to access/analyze their data and administer their
service. For additional information about the customer web interface, see the FortiPortal User Help (which is also
available by clicking the help button in the customer web interface).
The administrative web service allows the service provider to configure the services for each end customer, and to
manage the overall cloud service.

End-Customer Devices
The FortiPortal requires that the customer FortiGate devices must be managed by FortiManager. FortiManagers
may reside in the customer network or in the MSSP cloud.

1. FortiGate: security devices in the customer environment:
l
generates the security logs
l

passes logs to the collector

l

also fulfills the AP Wireless Controller role

2. FortiManager: manages a set of FortiGate devices:
l
All FortiGate devices in the FortiPortal must be managed by FortiManager
l

FortiManager provides device information to the FortiPortal

l

May reside in the customer network or in the MSSP cloud

3. (Optional) FortiAnalyzer: receives logs from the devices:
l
passes the logs on to the collector
l

May reside in the customer network or in the MSSP cloud

FortiPortal Concepts
FortiPortal introduces the following concepts:

Customer Sites
l

An end-customer can have multiple sites.

l

A site is a logical grouping of devices (independent of which FortiManager manages the device).

l

Devices are FortiGate devices or AP Wireless Devices.

FortiPortal 4.1.0 Release Notes
Fortinet Inc.
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Storage Limits
l

l

Each end-customer has a storage capacity maximum amount, which is expressed as a number of GB of database
storage.
The storage capacity is allocated between the two databases. The allocation is configurable per-customer. The
default allocation is as follows:
l
Portal Database (20% of the customer's storage amount)
l

Collector Databases (80% of the customer's storage amount)

If a customer exceeds their storage limit, one of the following strategies is applied (this is configurable for each
customer):
- Overwrite the oldest logs
- Stop Logging

Remote Authentication
You have the choice of local or remote user authentication of the Admin and Customer portal users. Local
authentication works by defining the users in the local user databases. Remote authentication provides a choice
of Radius authentication or FortiAuthenticator. The choice of authentication method is global to the whole
FortiPortal.
If you set the authentication mode to remote, all user management functions reside with the remote system.
FortiPortal user management capabilities (add/modify/delete users, reset password, change password) are
blocked, as these apply only to local users.
For additional information regarding FortiAuthenticator, refer to the FortiAuthenticator product documentation.

Trusted Hosts
If you are using local user authentication, you can add the Trusted Hosts capability as an added level of security.
You can apply the Trusted Hosts capability as a global feature. Optionally, you can add per-customer whitelists.
If you enable Trusted Hosts as a global setting, the system enforces a configurable blacklist and configurable
whitelist for all admin and customer users.
You can also enable Trusted Hosts as a customer setting. The system creates a whitelist of trusted hosts for the
customer users. The default entry in the whitelist is to allow all users, so you need to delete this entry to create a
real whitelist.

NOTE: For a customer with Trusted Hosts enabled, the system also enforces the global blacklist and whitelist for
the customer users.
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FortiPortal Installation
The following figure shows an example of a FortiPortal topology:

This chapter covers the following tasks:
l

"VMware Prerequisites" on page 12

l

"Basic Setup" on page 15

l

"Sample Configuration" on page 27

l

"Additional Setup Tasks" on page 29

The FortiPortal software runs on virtual machines where each VM runs either the Portal or the Collector software.
To create and manage the VM instances, you can use VMware.

NOTE: FortiPortal requires one VM for the Portal and one VM for each Collector. Therefore, FortiPortal requires a
minimum of two virtual machines (a minimum of four if you include the Portal and Collector databases).

CAUTION: FortiPortal is not a security appliance and should be afforded similar protection (such as firewalling,
IPS, and Web-application firewalls) as other Web applications maintained by the MSSP for its customers.

VMware Prerequisites
For KVM and OpenStack, see "Appendix: Installation Using OpenStack" on page 107.
This chapter assumes some familiarity with the VMware vSphere Client terminology.

FortiPortal 4.1.0 Release Notes
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Before deploying your FortiPortal using VMware, you must do the following:

1. Install the VMware vSphere Client on the management computer.
2. All VM instances run on VMware ESXi Server version 5.5 or later.
3. You must install a MySQL server for the Portal database and one or more MySQL servers for the Collector
database instances.
FortiPortal provides two installation alternatives. The choice of alternative determines the required OVF files that
you need to download.
l

Install the Portal and Collector as individual VMs. Required files for a new VMware installation:
o fpcvm64imageCollector.out.ovf.zip
o

l

ffpcvm64imagePortal.out.ovf.zip

Alternatively, both VMs can be installed as a virtual app. Required file:
o fpcvm64imagevApp.out.ovf.zip

Downloading OVF files
To download the required OVF files, follow these steps:

1. Navigate to the Fortinet customer service page (support.fortinet.com).
2. Download>Firmware Images.
3. On the Firmware Images page, select FortiPortal.
4. Download the latest versions of the required zip files.
5. Extract the packages to a local folder on the management computer.

Installing FortiPortal VMs
You have a choice of VM installation methods. You can install separate VM instances for the Portal and each of
the Collectors, or you can install the Portal and Collector as a VM vApp.
Installing the Portal and Collectors includes the following major steps:

1. Create a VM instance or a VM vApp. See "Create a VM instance " on page 13 or "Create a VM vApp" on page 14.
2. Configure VM hardware settings. See "Configure VM Hardware Settings" on page 15.
3. Power on the VM. See "Start the VM or vApp" on page 15.
4. Configure the Portal or Collector parameters.
The first time you start the Portal, you will have access only through the console window of your VM server
environment. After you configure the initial parameters, you can access the FortiPortal through the web-based
portal.

Create a VM instance
1. Download the Portal or Collector OVF file.
2. Launch the VMware vSphere client.
3. Enter the IP address or host name of your VMware server.
4. In the inventory menu, select the physical server where you will install the VM.
5. Select File > Deploy OVF Template to launch the OVF Template wizard. The wizard will guide you through a
series of deployment steps.
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6. Source: Use the Browse function to locate the OVF file:
l
Portal: FortiPortal-VM64.ovf
l

Collector: FortiPortal-VM64-Collector.ovf

7. OVF Template Details: This page displays the following information:
- FortiPortal version, size of the download, and application size on disk.
Click Next.
8. End-user License Agreement: Accept the end-user license agreement and click Next.
9. Name and Location: Enter a name for this virtual machine, select a location from the location inventory and click
Next.
10. Storage: Choose destination storage for the virtual machine files and click Next.
11. Disk Format: This page displays the storage device that you selected in the previous step, along with available
space. Select Thin Provision and click Next.
12. Network Mapping: Select the destination network to map to the source network in your OVF and click Next.
13. Ready to Complete: Review the deployment settings. Use the Back button to make any changes. When ready,
click the Finish button.

Create a VM vApp
1. Download the application OVF file.
2. Launch the VMware vSphere client.
3. Enter the IP address or host name of your VMware server.
4. In the inventory menu, select the physical server where you will install the VM.
5. Select File > Deploy OVF Template to launch the OVF Template wizard. The wizard will guide you through a
series of deployment steps.
6. Source: Use the Browse function to locate the OVF file for the application:
l
fpcvm64imagevApp.out.ovf.zip
or
l

fpcvm64imagevApp-mysql.out.ovf.zip

7. OVF Template Details: This page displays the following information:
- FortiPortal version, size of the download, and application size on disk.
Click Next.
8. End-user License Agreement: Accept the end-user license agreement and click Next.
9. Name and Location: Enter a name for this VM vApp, select a location from the location inventory and click Next.
10. Storage: Choose destination storage for the virtual machine files and click Next.
11. Disk Format: This page displays the storage device that you selected in the previous step, along with available
space. Select Thin Provision and click Next.
12. Network Mapping: Select the destination network to map to the source network in your OVF and click Next.
13. Ready to Complete: Review the deployment settings. Use the back button to make any changes. When ready,
click the Finish button.
The system creates a VM vApp using the name that you provided in step 9, as shown in the following figure:

FortiPortal 4.1.0 Release Notes
Fortinet Inc.
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Configure VM Hardware Settings
If required, adjust the VM CPU, memory and storage settings. The following are the default settings:
l

CPU: 2

l

Memory: 2 GB

l

Hard drive: 80 GB

To adjust these numbers, select the newly created VM in the inventory list and click Getting started>Edit
virtual machine settings.

Start the VM or vApp
In the inventory list, right-click the FortiPortal VM or vApp that you just installed and click Power On.

Basic Setup
NOTE: Portal interacts with FortiManager, and Collector, typically, interacts with FortiAnalyzer. To avoid Portal or
Collector becoming a bottleneck, you can adjust their maximum CPU and memory sizes so that they equal the
values for the FortiManager and FortiAnalyzer devices they interact with.

Basic setup covers the following tasks:
l

"Sizing" on page 15

l

"Database Installation" on page 17

l

"Portal Installation" on page 18

l

"Collector Installation" on page 21

l

"FortiManager Configuration" on page 26

Sizing
Before you start your setup, you need to determine the storage requirements for the Portal and Collector
databases. To do this, determine the approximate values for the following:
l

Expected log rate (logs per second)

l

Number of customers

l

Number of days to retain data

l

Number of FortiGate devices

NOTE: The values are based on one VDOM per customer and an 80/20 storage ratio of Portal database to
Collector database. If you are using FortiGate HA, count only the number of HA masters for the number of FortiGate
devices.

The expected log rate is the overall value for logs to the Collector. To find the number of logs per second for a
VDOM based on the last seven days of logs, use the diagnose test application command.
For example:
FG1K5D3I14801425 # diagnose test application miglogd 4
info for vdom: root

15
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memory
traffic: logs=63016358 len=34499571723, Sun=0 Mon=0 Tue=63016358 Wed=0 Thu=0 Fri=0
Sat=0
event: logs=2756 len=972616, Sun=324 Mon=324 Tue=345 Wed=324 Thu=740 Fri=375 Satt=324
The example shows the log counters for a seven-day period and gives the total number of entries for each log
type for each VDOM.
To calculate the number of log entries per second, take the sum of the logs (for example, 63,016,358 + 2,756 =
63,019,114), divide by 7 (for example, 63,019,114/7 = 9,002,731), and then divide by 86,400 (for example,
9,002,731/86,400 = 104) to get the number of logs per second.
A single Collector instance (Collector and database) can handle 15,000 logs per second. Portal supports multiple
Collectors on multiple VDOMs to increase the log rate and storage.
The following calculations can be used to determine the storage values for the Collector and the Portal and
Collector databases:
Syslog /second /customer = expected log rate / number of customers
Portal database size in MB for one syslog /second /day size = 0.156
Portal database size in GB /customer /day = (syslog /second /customer * 0.156) / 1024
Portal database size /customer to retain data = Portal database size in GB /customer /day * number of
retention days
Minimum customer storage = Portal database size /customer to retain data / (0.8 * 0.2) (The minimum
value is 5 GB.)
Collector disk size = 2.65 + (number of FortiGates * 3.25) (The minimum value is 80 GB.)
Portal database disk size = minimum customer storage * number of customers * 1.25 * 0.2 + 20
Collector database disk size = minimum customer storage * number of customers * 1.25 * 0.8 + 20

NOTE: Values in boldface are either buffer values or allocations for system files.
For example:
Expected log rate

500

Number of customers

5

Number of retention days

60

Number of FortiGates

10

When you substitute these values into the calculations:
Syslog /second /customer = 500 / 5 = 100
Portal database size in GB /customer /day = (100 * 0.156)/1024 = 0.015
Portal database size /customer to retain data = 0.015 * 60 = 0.914
Minimum customer storage = 0.914 / (0.8 * 0.2) = 5.712 ~ 6 GB

FortiPortal 4.1.0 Release Notes
Fortinet Inc.
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Collector disk size = 2.65 + (10 * 3.25) = 35.15 GB, so use the minimum value of 80 GB
Portal database disk size = 6 * 5 * 1.25 * 0.2 + 20 = 27.5 GB
Collector database disk size = 6 * 5 * 1.25 * 0.8 + 20 = 50 GB

Database Installation
NOTE: Fortinet does not provide this server as part of FortiPortal. Fortinet makes no recommendations on OS (or
version) for the database server image, other than recommending that the OS can run the required MySQL
supported release(s). Fortinet supports the MySQL databases created by FortiPortal and the connections to them.

The following is the overall installation procedure, which starts by configuring the database servers:

1. After you create the database server image, you must install two instances, one for the Portal database and one
for the Collector database.
2. Create the server VM and install the MySQL server.
l
You can use your company's standard server image.
l
FortiPortal supports both MySQL 5.5 and 5.7.
3. Install Portal. Portal requires a license.
4. Install Collector(s). (No licenses are required for Collector, so you can add as many Collectors as needed if you
need more log storage and an increased logging rate.)
5. After FortiPortal is running, you can add FortiManager devices and set up customers. See "Add a FortiManager"
on page 58 and "Add or Edit Customer" on page 38.

After you create the server VM and install the MySQL server, configure the following settings. The following
examples use the Ubuntu server.

If you are using MySQL 5.5, do the following:
1. Set the MySQL server bind-address parameter in the [mysqld] section of the following file:
/etc/mysql/my.cnf
2. From the MySQL console, use the show variables command to check that the following parameters are
correctly set:
mysql -u root -p

3. Create a user for Portal, grant privileges, and check that the user is created. For example:
> create user 'fpc'@'%' identified by 'fpc';
> grant all privileges on *.* to 'fpc'@'%';
> select the user from mysql.user;

4. Use the MySQL client (such as HeidiSQL) to check the remote connection using the new Portal user.

If you are using MySQL 5.7, do the following:
1. Set the MySQL server bind-address parameter in the [mysqld] section of the following file:
/etc/mysql/mysql.conf.d/mysqld.cnf
2. In the same file, set the sql_mode parameters (bind-address = 10.220.64.121):
sql_mode = STRICT_TRANS_TABLES,NO_ZERO_IN_DATE,NO_ZERO_DATE,ERROR_FOR_DIVISION_BY_
ZERO,NO_AUTO_CREATE_USER,NO_ENGINE_SUBSTITUTION

3. From the MySQL console, use the show variables command to check that the following parameters are
correctly set:
mysql -u root -p
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4. Create a user for Portal, grant privileges, and check that the user is created. For example:
> create user 'fpc'@'%' identified by 'fpc';
> grant all privileges on *.* to 'fpc'@'%';
> select the user from mysql.user;

5. Use the MySQL client (such as HeidiSQL) to check the remote connection using the new Portal user.

Portal Installation
1. Install the Portal VM image. For a new VMware installation, use the fpcvm64imagePortal.out.ovf.zip
file. For the KVM version, see "Appendix: Installation Using OpenStack" on page 107.
2. Configure the CLI settings. The following commands show the configuration for the example topology:
config system global
set hostname portal
set timezone 28 #use ? to identify the correct value for your region
end
config system interface
edit port1
set ip 10.220.64.120/24
set allowaccess ping https ssh http
end
config system route
edit 1
set device port1
set gateway 10.220.64.1
end
config system sql
set status remote
set database-name fp_fazlite
set database-type mysql
set password #xyz
set server 10.220.64.121
set username fpc
end

3. Check the NTP settings with the show system ntp command. Modify the settings for your environment if
necessary.
4. Reboot the VM.

FortiPortal 4.1.0 Release Notes
Fortinet Inc.
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5. Use an SQL client (such as HeidiSQL) to check that the database was created.

6. Log in to Portal using the user name spuser and the password test123:
https://10.220.64.120/fpc/login
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The top banner is common for all of the pages (Dashboard, Customers, Devices, Admin, Audit) and
includes the following action buttons (see the following figure):
l

Help - opens the Help system

l

Alerts - opens a pop-up window that displays alerts for the selected duration

l

Customers - opens the Customer page. Also displays the number of customers

l

Users - opens a pop-up window for adding MSSP users or managing existing users

l

Change Password - raises a dialog box for password change

l

Logout - logs out the current user

The top banner also displays the storage usage for this customer, including the storage limit allocated
and the actual amount of storage currently in use.
The top banner includes the main menu, which contains the following selections:
l

Home - return to home page (Dashboard page by default)

l

Dashboard - widgets that display information about the FortiPortal

l

Customers - page for managing end customers, including customer sites, users and reports

l

Devices - page for managing devices: FortiManager units and FAP Controllers

l

l

l

l

Admin - page for managing FortiPortal Collectors as well as settings for general Admin, Roles, Logs, and
GUI theme
Audit - displays an audit of the user log entries

To ensure system security, you should change the password for this user ID immediately (use the change
password command on the page banner).
If your FortiPortal license expires, go to Admin>System Info to upload a new license. See "Upload
License" on page 94for details.

7. Click Admin>Settings to specify the data store size (see "Sizing" on page 15) and the email settings. If you want
to use remote authentication, see "Admin Settings" on page 70 after you have finished the basic setup.

FortiPortal 4.1.0 Release Notes
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Updating SSL Certificate File
Use the following steps to import an SSL certificate for the FortiPortal VM.
From the Admin portal, click Admin>System Info to display information about the SSL certificate.

System Info page

The Certificate Information panel displays the certificate file name and private key file name.
From this panel, you can select and upload a new certificate and private key for the FortiPortal (using the PKCS#8
format).

Collector Installation
Use the following instructions to install and configure the first Collector. You can add multiple Collectors for more
storage and an increased log rate.

1. Install the Collector VM image using the fpcvm64imageCollector.out.ovf.zip file.
2. Configure the CLI settings. The following commands show the configuration for the example topology:
config
set
set
end
config

21

system global
hostname collector
timezone 28
system interface
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edit port1
set ip 10.220.64.122/24
set allowaccess ping https ssh http
end
config system route
edit 1
set device port1
set gateway 10.220.64.1
end
config system sql
set status remote
set database-name fp_fazlite
set database-type mysql
set password xyz
set server 10.220.64.121
set username fpc
end

3. Check the NTP settings with the show system ntp command. Modify the settings for your environment if
necessary.
4. Reboot Collector.
5. Log in to the Collector's management GUI to verify the installation:
https://10.220.64.122:4443

Configuring the Collector VM Disk Size
When you deploy the OVF image for the first time, you can configure the disk size. There are two virtual disks.
Hard disk 1 is the flash disk (2 GB); hard disk 2 is the storage disk (80 GB by default.). You can increase the size
of the storage disk when deploying the VM. See the following figure. (Do not increase the size of hard disk 1.)
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When Collector is running, use the execute lvm info command to see the disk size.

If you have already deployed the Collector VM, you can add an additional disk.

23
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To add a disk:

1. Shut down Collector.
2. Edit the VM properties.
3. Add an additional disk. See the following figure.

4. Start Collector.
5. Use the lvm info command again. You should now see an additional, unused disk.
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6. Enter the execute lvm extend comand to use the new hard disk. The Collector will reboot.

7. When the Collector is running, use the execute lvm info command to see the new disk size.

Adding the Collector to Portal
1. Log in to Portal using a service-provider user account using the user name spuser and the password test123.

25

FortiPortal 4.1.0 Release Notes
Fortinet Inc.

Basic Setup

FortiPortal Installation

2. Click Admin>FPC Collectors and then click +Add.

3. Enter a name and the IP address of the Collector.
4. Select Standalone for the mode. If you are configuring a Collector HA, select Master.
5. Enter the Collector user name and password . By default, the user name is admin.
6. Enter the Collector database IP address, user name, and password.
7. Enter the data storage size in GB.
8. Click Save.
9. Because Portal configures the Collector database schema, check that both the fp_fazlite_# and fp_fazlite_#_
cache have been created.
10. Check the data store size again. It should be larger now that it includes the Collector.

NOTE: The storage indicator increments by the Collector database storage allocation. The overall storage indicator
combines Portal's database and all Collector databases.

FortiManager Configuration
You will need to configure FortiManager to work with FortiPortal.

1. If needed, enable ADOMs and the advanced adom-mode on FortiManager so that you can add VDOMs on the
same physical device to different ADOMs:
config system global
set adom-status enable
set adom-mode advanced
y
end

2. Create a Portal user with read-and-write permission:
config system admin user
edit fpc
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set
set
set
set
set
next
end

Sample Configuration

profileid Super_User
adom all_adoms
policy-package all_policy_packages
password fortinet
rpc-permit read-write

3. If needed, enable the workspace mode:
config system global
set workspace-mode normal
end

4. Add your FortiManager device using the JSON API. You must poll FortiManager to see the device list. For more
information about adding FortiManagers to Portal, see "FortiManager Devices" on page 57.

Sample Configuration
This section contains procedures for adding a sample customer ADOM using device models. These procedures

are optional and are for testing purposes only.

Sample ADOM and VDOM Configuration
1. In FortiManager, create a customer ADOM by going to System Settings > All ADOMs and clicking Create
New in the toolbar. Select FortiGate as the type and select 5.4 as the version.
2. From the root ADOM, select Lock from the banner to lock the ADOM.
3. To add a model device with the Add Device wizard, go to Device Manager>Device & Groups and click Add
Device. Enter the values shown in the following figure:
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4. Verify that the model device was successfully added.

5. From your model device, enable VDOMs.
6. To add a new VDOM, go to Device Manager>Device & Groups, click the group in the tree manager, right-click
a device in the content pane, and select Add VDOM. Use the Tools>Display options to display the virtual
domain menu.
7. To move the customer VDOM to the customer ADOM, go to System Settings>All ADOMs, double-click an
ADOM, right-click an ADOM, and select Edit.
8. Go to Policy & Objects>Policy Package to create a policy package and then assign it to the customer VDOM.
9. Create a few policies and install the policy package by selecting Install>Install Wizard.

Sample FortiPortal Configuration
1. In FortiPortal, poll your FortiManager device to see your new ADOM and device listed under
Devices>FortiManager.
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2. Create a new customer. For details, see "Add or Edit Customer" on page 38.

3. Assign your ADOM and configure the device, policy, and object permissions.

4. Create a customer site. For details, see "Customer Sites" on page 45.
5. Move your mouse over the site to see the site icon.
Customer sites are used in reports to group devices. Devices are assigned to customer sites, but the configuration
is done at the customer level.
6. Create a Portal user for this customer. For details, see "Create a User" on page 30.
You can now configure policies and objects for the customer ADOM, using either the customer or service provider
accounts.

Additional Setup Tasks
After performing the basic installation, there are additional setup tasks to fully complete your configuration:
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l

To add additional Collectors or to configure Collector HA, see "FortiPortal Collectors" on page 67.

l

To add additional FortiManager devices, see "FortiManager Devices" on page 57.

l

To add wireless controllers, see "AP Controller Devices" on page 61.

l

To add FortiAnalyzer devices, see "FortiAnalyzer Devices" on page 64.

l

To create an end customer, see "Add or Edit Customer" on page 38.

l

To create customer sites, see "Customer Sites" on page 45.

l

To create site administrators, see "Customer Users" on page 50.
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Administrative Users
Clicking the

icon on the top-right hand side displays the list of FortiPortal service provider administrators.

NOTE: These users are local users. The described commands are available only when Admin
Settings>Authentication Access is set to LOCAL.

Page Actions
On this page, the following actions are available:
l

Add - open a new page with the form to add an MSSP user

l

Search - enter text to search for user names containing that text

Per-User Actions
When you scroll over a entry in the users list, the following icons appear in the Action column:

1.

- opens a new page with the form to edit the data for this user

2.

- deletes the entry. (NOTE: You cannot delete the default admin user.)

3.

- opens the Trusted Host list

Create a User
1. From the USSP user page, click the Add button.
2. Input the fields, as described in the table below.
3. Click the Save button.
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Trusted Hosts

The following table describes the fields in the add/edit form:

Settings

Guidelines

First Name
Last Name

Name of the administrator

Password Policy

Enable or disable. If enabled, you can set one or more of the following types of
character that the password must contain:
Uppercase Letters
Lowercase Letters
Numbers (0-9)
Special Characters

Password

The administrator uses these credentials to access the customer portal. The
password must meet the requirements set by the password policy.

Email

Email address of the administrator

Address

Business address for the administrator

Phone and Fax

Phone and Fax number

Available Roles

Roles that are available for this user type

Selected Roles

Selected roles for this user

Status

Active or Disabled

Trusted Hosts
If you enable Trusted Hosts as a global setting (see Admin Settings), the system enforces a configurable trusthost blocklist and whitelist for all admin and customer users.
You can also create a global trusted-host whitelist and subsequently open the list by clicking the Trusted Host
action. The following figure shows a list with only the default entry:
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From the whitelist, you can edit/delete an existing trusted host, or add a trusted-host entry. The Add/Edit Trusted
Host form contains the following fields:

Settings

Guidelines

IPv4
IP Start

Start address for the range covered by this entry

Mask

Defines the range of IP addresses

IPv6
IP Start

Start address for the range covered by this entry

:Prefix

Defines the range of IP addresses covered by this entry

Admin User Roles
The purpose of roles is to authorize each user to view and modify only the content that is required for that user.
For example, a system administrator requires write access to the pages required for FortiPortal configuration, but
does not need write access to the customer information.
Each role defines the access rights of the user to specific FortiPortal pages and components. The user may have
read-write access to the content, or it may be hidden/read-only.
You can assign one or more roles to a user. For example, a user with Sys Admin and FortiPortal Admin roles is a
"Super Admin", with read-write access to all Service Provider pages and all Customer Portal pages.
The system provides a set of default administrative roles. Using the FortiPortal Roles user interface, you can also
create new roles or customize the default roles.
The following table describes the default roles for administrative users:

Settings

Guidelines

System Admin

The System Admin role provides read-only access to all of the FortiPortal pages.
In addition, this role provides read-write access to Collectors, Admin Settings,
System Log and Themes.
The customer portal is hidden for the Sys Admin role.

FPC Admin

The FortiPortal Admin role provides read-write access to all of the FortiPortal
pages. but with read-only access to Collectors, Admin Settings, System Log and
Themes.
The FortiPortal Admin role also provides read-write access to the customer
portal.

Admin Monitor

The System Admin role provides read-only access to all of the FortiPortal admin
portal and the Customer Portal.
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Dashboard
The dashboard displays information about the FortiPortal and is organized as a set of widgets.

Actions available (at the top of the Dashboard page):
l

+ Widget - add a widget to the dashboard

l

Filter - filter the data based on time (last 60 minutes, last 1 day, last 7 days, or specify a custom filter)

l

Refresh - refresh the display for all of the widgets on the page

The dashboard includes the following default widgets:
l

l
l

l
l

l

l

Top Total Cloud Usage By Customer
l
Hover your cursor over each customer to view the detailed usage numbers
Top Traffic By Customer
Cloud Usage Trend
l
Hover your cursor over each customer to view the detailed numbers over the selected usage period
Top 5 Customers By Max Client Count (Wireless)
Top 5 Customers By Aggregate Traffic (Wireless)
l
Hover your cursor over each customer to view the detailed traffic numbers
Fortinet Access Point (FAP) Summary
l
Click on the pie chart to view a list of the FAPs that are up (click the left side) or FAPs that are down (click
the right side of the pie chart)
Top Sandbox Customers

The title bar on each widget provides the following controls:
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l

Edit Settings - opens a new page with a form to edit the widget details

l

Refresh - refresh the widget display

l

Delete - delete the widget

l

Collapse/Expand - collapses the widget to display only the title bar

l

Drag and Drop - click and hold the title bar of the widget to change its position on the page
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Dashboard

Initial Data-Aggregation Delay
Once FortiPortal begins to receive logs from the devices, you might experience a delay of up to 15 minutes before
the aggregated data appears on the dashboard.

Ability to set Top N Entries
From among the tools on the upper right on any widget, you can use the Edit Settings icon to configure to show
5, 10, or 15 values:

A screen opens within the widget enabling you to select top N entries (5,10, 15):
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Dashboard

Ability to set Top N Entries

Choose a number and click OK to refresh the report:
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Customers
The Customer tab displays a list that shows summary information for each customer (customer name, amount
of storage allocated, and the percentage of their storage allocation that has been used).

Page Actions
On the customer page, the following actions are available:
l

Add - open a new page with the form to add a customer

l

Search - enter text to search for customer names containing that text

Per-Customer Information
The system displays the following information for each customer:

Field

Description

Allocated Storage (GB)

Total amount of storage allocated for this customer

Total Storage (%)

Percentage of the total storage that the customer is currently using

Portal Storage (%)

Percentage of storage allocation (the customer is using) devoted to the portal

Collector Storage (%)

Percentage of storage allocation (the customer is using) devoted to the collector

FGT VDOM /
FSA Devices

Devices - the number of FortiManager/FortiAP devices that are registered to this
customer
FSA Devices - the number of FortiSandbox devices that are registered to this
customer
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NOTE: The system displays the percentage of Portal and Collector storage allocations that the customer is using
(not the percent of the total customer storage). These storage allocations are configurable in the add/edit customer
forms.

Per-Customer Actions
Hovering over an entry in the customer table displays the following icons in the Action column:
l

Edit - opens a new page with the form to edit the customer data

l

Delete - deletes this customer

l

Sites - opens a pop-up window with a list of sites for this customer

l

Users - opens a pop-up window with a list of users for this customer

l

Reports - opens a pop-up window with a list of reports for this customer

When you click on a customer name in the list, the system opens the customer portal for this customer (in a new
tab).
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Add or Edit Customer
Clicking the + Add button on the upper right of the Customer List displays a form for adding a new customer
(fields in the form are blank). (Hovering over any entry in the Customer List display, and clicking the Edit
Settings icon displays the Edit Customer form, which is identical to the Add Customer form except that fieldsare
set to the values for this customer.)

To add or edit a customer:

1. Input the fields, as described in the tables below.
2. Click the Save button.
The Customer form comprises a number of panels. The following sections describe the fields in each panel.

Customer Details and Contact Information
This panel contains basic information about the customer:
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Per-Customer Actions

Guidelines

Customer Details
Customer Name

Customer's business name, which must be unique within this FortiPortal

First Name, Last Name
Email

Name and email of the primary customer contact

Use MSSP Locale

Uses the MSSP locale (the language configured in Admin Settings)

Language

If you deselect the Use MSSP Locale option, you can select a language for this
customer. When a customer user logs in to the User Web Interface, pages will
display in this language. For Administrative users, the system will continue to
use the language set in the Admin Settings.

Attach Logo

Download an image file for this customer's logo.

Domains

When using remote authentication, a customer may have users defined in more
than one domain.
Enter a domain, then click the green + button. The new domain appears in the
list below the entry box.

Contact Information
Address, Phone, Fax

Address fields, phone and fax numbers for this customer

Cloud Properties
This panel contains information about portal and collector storage for this customer.
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Settings

Guidelines

Total Storage

Total number of GB of storage that this customer can use. The default value is 5
GB.

Collector/Portal Storage
Percentage

Storage ratio for Collector DB and Portal DB. By default, 80% of the storage
allowance is allocated to the Collector DB, and 20% is allocated to the Portal DB.

Analytics

Enable or Disable. If you disable analytics for a customer, the Dashboard, Views
and Reports pages will not be displayed to that customer.
If you disable analytics when adding a new customer, the system allocates less
storage space for the customer (1GB instead of 5GB).
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Settings

Guidelines

When Allocated Disk
Space is Full

Choice of two options:
- Overwrite the Oldest Logs
- Stop Logging

Trusted Hosts

Enable or Disable trusted hosts for this customer. For additional information
about trusted hosts, see Customer Users.

Policy Installation Scheduler
Enables you to schedule automatic policy installation at a particular time (daily or weekly; default, none). All the
pending policy updates will be installed at the configured schedule.
In the Others section of the customer record, navigate to the Policy Installation Scheduler.
Notice the scheduler dropdown with the frequency options (none, daily, and weekly).

Frequency: None (the installation scheduler will not be invoked for this customer):
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Frequency: Daily (displays a lookup field to select the time of day to run the scheduler):

Frequency: Weekly (displays a drop-down and look-up fields to select the day and time of the week to run the
scheduler):

Policy and Object Permissions
This panel configures the policies and objects that a customer can modify.

NOTE: Policies and objects will not be visible to the customer in the customer web interface unless you select them.
For example, if you select Web Filtering, a web filter object will display in the object tree and a web filter column
will display in the Policy tab:

Settings

Guidelines

Policy and Object Permissions
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Settings

Guidelines

Check boxes for Policies
and Objects

You can set or unset the edit permissions for each of the policy/object
categories:
AntiSpam, Application Control, Firewall Policy,
DLP Sensor, AntiVirus, Firewall Address,
Web Filtering, Schedule, IPS Sensor,
User, User group, Virtual IP,
Local Category, Rating Overrides, Service

Policy Tab Permissions
This pane determines which policy tabs are visible in the customer web interface. Check the boxes for tabs that
you want to make visible for this customer. Select All to make all of the tabs visible.

Tab Permissions
This pane determines the tabs that are visible in the customer web interface. Check the boxes for tabs that you
want to make visible for this customer. Select All to make all of the tabs visible.
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NOTE: You must include at least one of the following tabs: Dashboard, Policy, or Objects.

Widget Permissions
This pane determines the widgets that are available in the dashboard of the customer web interface.

NOTE: If you selected Tab Permissions> Dashboard, you must select at least one widget for display in the
dashboard.

Use the arrow keys to move the widgets from the left panel to the right panel (these widgets will appear in the
dashboard for this customer). The double-arrow keys move the entire list.

ADOM Filter Permissions
This pane determines the devices that will be listed for a customer in drop-down menus of devices.
Use the arrow keys to move values from the left panel to the right panel.

Object Filter
Adding an Object name to Object filter will hide the object from the customer user. This will enable MSSP users
to hide any objects which need to be hidden from customers users.
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Policy Filter
Comments made in a policy can be added as filters in this section to hide the policy from customer users.
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Customer Sites
Hovering over an entry in the Customer List page "dynamically-creates" a set of action icons:

Clicking the Sites icon displays information about the customer sites. For each site, you see the name, devices,
and email address of the site administrator:

Page Actions
The Sites page contains the following actions:
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l

Add - open a new page with the form to add a site

l

Search - enter text to search for site names containing that text
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Per-Site Actions
When you scroll over a entry in the Sites list, the following icons appear in the Action column:

l

Wireless Network - opens a pop-up window with a list of wireless networks for the selected site

l

Edit - opens a new page with the form to add a site or edit existing site data

l

Delete - deletes the selected site

Clicking the + Add button displays the Add/Edit Site forms (clicking the Edit Settings icon under Actions
displays an identical form with fields supplied):

The forms contain the following fields:
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Settings

Guidelines

Site Name

Name for the Site, which must be unique across this customer's sites

Contact Name
Email
Phone

Name and email of the customer contact for this site

Available Devices

List of discovered FortiGate devices (with the format: ADOM/Device/VDOM
Use the search box to filter the choices available.

Selected Devices

Select the devices to associate with this site. Ensure that you add only the
devices with the correct ADOM for this customer.
Use the search box to filter the choices available.

Enable sandbox for all
selected devices
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Set this option if you want to enable sandbox capability for all of the selected
devices.
NOTE: An extra license is required for each device that you enable with
sandbox.
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Wireless Networks
Clicking the Wireless Network icon on the Customer Sites page displays the Wireless Networks window for a
given site. This window displays information about the site's wireless networks (network name, FAP list, email of
the administrator):

From this window, you can add wireless networks to the site, edit a site, and edit the list of associated Fortinet
Access Points.

Page Actions
On this page, the following actions are available:
l

Add Wireless Network - open a new page with the form to add a wireless network

l

Search - enter text to search by network name, device or email

Clicking the Add Wireless Network button displays a form for adding a new network (fields in the form are
blank).

Per-Network Actions
When you scroll over a entry in the wireless network table, the following icons appear in the Action column:
l

Edit - opens a pop-up window with a form to edit the wireless network data

l

Delete - deletes the selected wireless network

Clicking the Edit icon displays the Edit Customer form which is identical to the add form except that the fields are
filled:
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Wireless Networks

Per-Network Actions

When you add or edit a wireless network, the form contains the following fields:

Settings

Guidelines

Wireless Network Name

Name for the wireless network

Contact Name
Email
Phone

Name and email of the customer contact for this network

Available Devices

Lists of discovered wireless AP devices
Use the search box to filter the choices available.

Selected Devices

Select the wireless AP devices to associate with this network.
Use the search box to filter the choices available.
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Customer Users
Clicking the User(s) icon on the Customer List page displays the Customer Users page, which displays
information about the local administrative users configured for this customer.

NOTE: These users are local. The described commands are available only when Admin
Settings>Authentication Access is set to Local.

Page Actions
On this page, the following actions are available:
l

Add - open a new page with the form to add a user

l

Search - enter text to search for user names containing that text

Per-User Actions
When you scroll over a entry in the users list, the following icons appear in the Action column (numbers refer to
the callout labels in the figure below):

1.

- opens a new page with the form to add/edit data for existing users

2.

- deletes this user

3.

- opens a new page with the form to add a trusted-host entry for this customer

Add or Edit User
The Add User and Edit User forms contain the following fields:

Settings

Guidelines

First Name
Last Name

Name of the user
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Settings

Guidelines

Email
Password

Email and password for the user. The user will use these credentials to access
the customer portal.

Address

Business address for the user

Phone and Fax

Phone and fax number for the user

Available Roles

Roles that are available for this user type. You can specify multiple roles for a
user.

Selected Roles

Selected roles for this user

Status

Active or Disabled

Add Trusted Host for a User
If you have enabled the Trusted Host option for this customer, the system creates a whitelist of trusted hosts for
the customer users. The default entry in the whitelist is to allow all users, so you need to edit/delete this entry to
create a valid whitelist.
Click the Trusted Host action to open the whitelist for this customer. In the following figure, we show a list with
only the default entry:

From the whitelist, edit/delete an existing trusted host, or add a trusted-host entry for this customer.
The Add Trusted Host and Edit Trusted Host forms contain the following fields:

Settings

Guidelines

IPv4
IP Start
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Start address for the range covered by this entry
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Settings

Guidelines

Mask

Defines the range of IP addresses covered by this entry

IPv6
IP Start

Start address for the range covered by this entry

:Prefix

Defines the range of IP addresses covered by this entry

Customer User Roles
User roles enable you to authorize each customer user to view and modify only the content that is required for
that user.
Each role defines the access rights of the user to specific Customer Portal pages and components. Content may
be hidden from the user, read-only, or read-write access.
You can assign one or more roles to a user. For example, a user with Schedule Report Write and RunNow Report
Execute roles will have read-write access to the Reports page and the RunNow page, and read-only access to the
remaining pages and components for that customer.
The system provides a set of default customer user roles. You can also create new roles or customize the default
roles using the FortiPortal Roles user interface.
There are numerous default roles, but note the following common points:
l

l
l

l

l

The Customer Monitor role provides read-write access to the pages that a user requires to administer the Customer
Portal for that customer. Because this role is far-reaching, we recommend that you assign this role to a limited
number of users.
All of the customer roles provide read-write access to the dashboard.
All of the "Read" roles provide read access to all of the customer pages (except that the Run Now Report page is
hidden). In addition, the role allows read-only access to the resource that the role name specifies (such as Policy,
Address Object, Schedule Object).
Each of the "Write" roles provide read-only access to the same resources as the "Read" role, except that it also
allows write access to the resource that the role name specifies (such as Policy, Address Object, Schedule Object).
The RunNow Report Execute role allows access to the RunNow page, so that the user can run reports. On the
report page, the Run Now button is hidden for users without this role.

NOTE: To provide a customer user with read-write access to a specific object or policy, you must set the
corresponding write permission for this customer in the Customer data. Refer to Policy and Object Permissions
in Add or Edit Customer.

The following table describes the default role types that are available:

Role

Description

Customer Admin

Read-write access to the pages that an user requires to
administer the Customer Portal for that customer
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Role

Description

Schedule Report Read

Read access to the Report Definitions page

Schedule Report Write

Read access to the Report Definitions page and allows the user
to add or edit a customer-defined report

Run Now Report Execute

Makes the Run Now button visible on the Reports page and
enables the user to select a report and run it

Policy Read

Provides the user with read-only access to the policies

Policy Write

Provides the user with read-write access to the policies

Object Read

Provides the user with read-only access to the specified object
type. Object types include:
Address Object, Schedule Object, Anti Virus Object, Application
Sensor Object , DLP Object, Email Filter Object, IPS Sensor
Object, Web Filter Object.

Object Write

Provides the user with read-write access to the specified object
type

FortiPortal 4.1.0 Release Notes
Fortinet Inc.

FortiPortal Reports

Reports

Reports
The service provider can create reports for the customer. Similarly, the customer can also create reports. The
ability (for a specific customer user) to create reports or run reports is based on the roles assigned to that user.
For additional information, refer to Customer Users.
The Reports tab displays information about the reports that are available to this customer. From the selector on
the top left of the page, you can select FortiPortal or FortiAnalyzer reports.
In the Admin>Settings page, you specify the maximum number of reports (Max Reports Allowed) that can be
defined for this customer. This number includes customer-defined reports and reports added by the service
provider. If you try to add a report beyond the maximum number for this customer, the system will display an error
message.

FortiPortal Reports
The following figure shows the Reports>FortiPortal page, which lists the user type and frequency for each
report:

Page Actions
The FortiPortal Reports page contains the following actions:
l

Select - select FortiPortal or FortiAnalyzer

l

Add - open a new page with the form to add a report

l

Search - enter text to search for report names containing that text

Per-Report Actions
When you scroll over a entry in the reports list, the following icons appear in the Action column:
l

Edit - opens a new page with the form to edit the selected report

l

Delete - deletes this report
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Reports

FortiAnalyzer Reports

The Add Report and Edit Report forms contain the following selections:

Settings

Guidelines

Report Name

Name for the report.

Frequency

Values include: Daily, Weekly, Monthly.

Available/Selected
Reports

Use the arrow keys to create a list of selected reports by using the list of available
reports.
Use the search boxes to filter the choices available.

Available/Selected
Sites

Use the arrow keys to create a list of selected sites from the list of available sites.
If no sites are selected, the report is run for all sites.
Use the search boxes to filter the choices available.

Locale

Select the language for the report from the drop-down list.

No of Rows

Number of rows of data to include in the report.

From Email

Enter email address from which the report will be sent.

Email Text

Enter text for the body of the email.

FortiAnalyzer Reports
The following figure shows the Reports>FortiAnalyzer page, which includes the reports that are available on all
of the FortiAnalyzers devices associated with this FortiPortal.
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FortiAnalyzer Reports

Reports

Page Actions
The FortiAnalyzer Reports page contains the following actions:
l

Select - select one or more report (boxes) to assign or unassign to a customer

l

Show x entries - sets the number of entries that are displayed at once (8, 25, 50, or all)

l

Assign - assigns the selected reports to this customer who can view a report or download a PDF of the content

l

Unassign - removes the selected reports from this customer

l

Search - enter text to search for report names containing that text

NOTE: If you assign a report to a customer for a given ADOM, the other reports for that ADOM are unavailable to
other customers.
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FortiManager Devices

Page Actions

FortiManager Devices
From the main menu, clicking Devices>FortiManager displays a list of FortiManager devices, wireless
AP controllers, or FortiAnalyzer devices:

Page Actions
On this page, the following actions are available:
l

Add - open a new page with the form to add a FortiManager

l

Search - enter text to search for FortiManager names containing that text. You can also search by IP address.

Per-FortiManager Actions
When you scroll over a entry in the FortiManager list, the following icons appear in the Action column:
l

Edit - opens a new page with the form to edit the FortiManager data

l

Delete - deletes the selected FortiManager

l

Poll - polls the selected FortiManager

l

Show HA - clicks the HA icon to display the FortiManagers in this HA cluster

l

Expand - clicks the green + button to view a list of the devices managed by this FortiManager

l

Hide - clicks the red - button to hide the devices

FortiManager High Availability (HA)
A FortiManager HA cluster consists of an active master unit, and up to four standby slave units. If the master unit
becomes unavailable, one of the standby slaves will become the new master.
In most situations, the FortiPortal provides access to the master FortiManager in the HA cluster. Configuration
changes in the master will be synchronized to the slave units. If no master exists, the FortiPortal provides readonly access to the slave units.
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Add a FortiManager

FortiManager Devices

In the FortiManager table, the Mode includes the following values:
l

Standalone - the FortiManager is independent of a high-availability cluster

l

Master - the FortiManager is the master in a high-availability cluster

l

Slave - the FortiManager is a slave in a high-availability cluster

Click the HA icon to display information about the FortiManagers in this HA cluster:

The Cluster Information page provides the following information for each FortiManager in the cluster:

Field

Description

FortiManager SN

Serial Number of the FortiManager

Active

Displays green arrow for an active FortiManager, or a gray x for an inactive
FortiManager

IP Address

IP Address of the FortiManager

Role

Master or Slave

Status

Indicates whether the FortiManager is operational

Add a FortiManager
Assuming that you have already acquired the credentials for an admin user on the FortiManager (create a
dedicated admin user for FortiPortal), do the following to add a FortiManager:

1. Click the Add button.
2. Input the fields, as described in the table below.
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FortiManager Devices

Edit a FortiManager

3. Click the Save button.
When you add a FortiManager, the FortiPortal polls the FortiManager immediately to obtain information about its
managed devices. The FortiPortal subsequently polls the FortiManager based on the configured polling
frequency.

Edit a FortiManager
To edit the FortiManager:

1. Click the Edit button (in the Action column).
2. Input the fields, as described in the table below.
3. Click the Save button.

The following table contains descriptions of the fields:
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Field

Description

FortiManager Name

A name for the FortiManager. The name must be unique within this FortiPortal.

IP Address

IP address of the FortiManager
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Manage FortiGate Devices

FortiManager Devices

Field

Description

Admin Username

User name for a valid FortiManager administrative user

Polling Frequency

How frequent the FortiPortal will poll the FortiManager to update the devices
information. If you set the frequency to No Polling, the FortiPortal will never
poll the FortiManager. Valid values include Daily, Weekly, Monthly.

Port Number

Port number for connecting with the FortiManager (default is 443)

Last Poll Time

Read-only field. Indicates when the FortiPortal last polled this FortiManager
device.

Manage FortiGate Devices
Clicking the green + button on the FortiManager List page displays a list of the FortiGate devices managed by
this FortiManager. The system displays an additional search box, for searching within the list of devices.
For each device, the system displays the following fields and action buttons.
l

Device - name of the managed FortiGate device

l

Status - status of the device

l

Customer Name - the customer name

l

Wireless - indicates whether this FortiGate device is functioning as a wireless controller. Clicking the icon displays
the Edit Wireless Controllers page. Enter the admin user name and password for the FortiGate unit, and desired
polling frequency. If the device is polled successfully, it will be added to the controller devices list.

NOTE: The system displays a cluster icon to represent a FortiGate cluster. Hovering over the icon displays the list of
individual FortiGate units in the cluster (see the figure below):
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AP Controller Devices

Page Actions

AP Controller Devices
Clicking Devices>Controllers displays a list of wireless AP controllers. (In the FortiPortal solution, the wireless
controllers are FortiGate devices.)

The list displays the controller name (with ADOM and VDOM), the IP address, and the polling frequency for each
controller. Polling frequency determines how often the FortiPortal will poll the device for any updated data.

For the FortiPortal to collect the data for this device, the SSID name and interface
name (configured on the FortiGate or FortiWireless controller) must match precisely.

Page Actions
On this page, the following actions are available:
l

Add - open a new page with the form to add a controller device

l

Search - enter text to search for controller names containing that text

Per-Controller Actions
When you scroll over an entry in the controller table, the following icons appear in the Action column:
l

Edit - opens a pop-up window with a form to edit the controller data

l

Delete - deletes the selected controller

Wireless icons:
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l

Wireless - indicates whether this FortiGate is acting as a wireless controller. Click the icon to toggle the status

l

Attention - wireless connectivity status of the FortiGate unit
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AP Controller Devices

Edit a Controller
To edit the controller :

1. Click the Edit button (in the Action column).
2. Input the fields, as described in the table below.
3. Click the Save button.
The following figure shows the form for Add Controller:

The following table contains descriptions of the fields:

Settings

Guidelines

Controller Name

Name for the controller. The combination of controller name and VDOM must be
unique within this FortiPortal
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AP Controller Devices
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Edit a Controller

Settings

Guidelines

VDOM

Virtual Domain to which this controller belongs

IP Address

IP address of the controller

Serial Number

Serial number of the controller

Admin Username

User name for the controller user assigned to this FortiPortal

Port Number

Destination port number for polling messages. The default is 443.

Polling Frequency

How often the FortiPortal will poll the controller to update the device information.
Values range from every 15 minutes to every 24 hours.
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Prerequisites

FortiAnalyzer Devices

FortiAnalyzer Devices
Clicking Devices>FortiAnalyzer displays a list of FortiAnalyzers. When you add a FortiAnalyzer device to the
FortiPortal, you make the reports on that FortiAnalyzer available to customers. Refer to the Customer Reports
page. The list displays the FortiAnalyzer name (with ADOM and VDOM), the IP address, and the status for each
FortiAnalyzer:

Prerequisites
Before you add a FortiAnalyzer device, use the FortiAnalyzer CLI to set the following configuration values:
1. Set permission level for the user to login via Remote Procedure Call (RPC).
config system admin user
edit <the admin user name assigned to the FortiPortal>
set rpc-permit read-write
2. Set port1 (assuming it is connected to the FortiPortal) to allow web service access.
config system interface
edit port1
set allowaccess https http ping telnet snmp webservice
aggregator fortimanager

Page Actions
On this page, the following actions are available:
l

Add - open a new page with the form to add a FortiAnalyzer device

l

Search - enter text to search for FortiAnalyzer names containing that text

Per-FortiAnalyzer Actions
When you scroll over an entry in the FortiAnalyzer table, the following icons appear in the Action column:
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FortiAnalyzer Devices

Edit a FortiAnalyzer

l

Edit - opens a pop-up window with a form to edit the FortiAnalyzer data

l

Delete - deletes the selected FortiAnalyzer

l

Poll - polls the FortiAnalyzer to obtain the most recent data

l

View - displays a list of FortiAnalyzer reports

Edit a FortiAnalyzer
To edit the FortiAnalyzer:

1. Click the Edit button (in the Action column).
2. Input the fields, as described in the table below.
3. Click the Save button.
The following figure shows the form to add or edit a FortiAnalyzer:

The following table contains descriptions of the fields:
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Settings

Guidelines

Name

Name for the FortiAnalyzer. The combination of FortiAnalyzer name and
VDOM must be unique within this FortiPortal.

IP Address

IP address of the FortiAnalyzer
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View FortiAnalyzer Reports

FortiAnalyzer Devices

Settings

Guidelines

Admin Username

User name for the FortiAnalyzer user assigned to this FortiPortal

Ports

Destination port numbers. The default for JSON is 443. The default for XML is
8080.

Polling Frequency

How often the FortiPortal will poll the FortiAnalyzer to update the device
information.
The default value is one day. The polling frequency is not configurable.

View FortiAnalyzer Reports
When you click the View icon for a FortiAnalyzer in the list, the FortiPortal opens a pop-up window:
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FortiPortal Collectors

Page Actions

FortiPortal Collectors
Clicking Admin>FPC Collectors displays a list of the FortiPortal collector devices. For each collector, the list
displays its IP Address, mode, status, and database storage size:

Page Actions
On this page, the following actions are available:
l

FPC Admin - open a new page with the log in screen for the collector

l

Add - open a new page with the form to add a collector

l

Search - enter text to search for collector names containing that text

Collector High Availability (HA)
A Collectors HA cluster consists of an active master unit, and one or more standby slave units. If the master unit
becomes unavailable, the standby slaves will become the new master.
Use the following steps to create a high-availability cluster:

1. Add one collector with the mode set to Master.
2. Click the HA icon in the mode column to open the HA Cluster window.
3. Click the Add Slave button to create the slave.

Add FortiPortal Collector
You need to add at least one collector to the FortiPortal:

1. Click the Add button.
2. Input the fields, as shown in the figure below. The fields are described in the table at the end of this section.
3. Click the Save button.
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Per-Collector Actions

FortiPortal Collectors

Per-Collector Actions
When you scroll over a entry in the FPC Collectors list, the following icons appear in the Action column:
l

Edit - opens a new page with the form to edit the collector data (page is identical to Add FPC Collector except for
the supplied values)

l

Delete - deletes the selected collector

l

View HA - opens a pop-up window with the HA Cluster information

Edit a Collector
1. Click the Edit button (in the Action column).
2. Input the fields, as described in the table below.
3. Click the Save button.
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FortiPortal Collectors

69

Edit a Collector

Settings

Guidelines

Name

Name for this collector. Each collector name must be unique within a FortiPortal.

IP Address

IP address of the collector

Port Number

Port number for connecting with the collector.
Default value is 443.

Mode

Standalone or Master

Collector Username

Valid user name for the collector

Collector Password

Password for the above user.

DB IP Address

The IP address of the collector MySQL database.

DB Port Number

Port number for the collector database.
Default value is 3306.

DB Username

Valid user name for the collector database.

DB Password

Password for the above user.

Data Store Size

The amount of database storage (in GB) to reserve for this collector.
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Edit a Collector

Admin Settings

Admin Settings
Clicking Admin>Settings displays general administrative settings for the FortiPortal. The following figure shows
the settings page (with authentication set to local):

The following table contains descriptions of the settings:

Settings

Guidelines

Administrative Settings
FPC Data Store Size

Amount of database storage (in GB) to reserve for the portal DB

Session Timeout

Timeout for user sessions on the Administrative or Customer web interfaces.
The default is 30 minutes. The range is 15-3240 minutes.

Trusted Hosts

Set to Enable or Disable. When enabled, you can create a whitelist of originating
IP subnetworks; only log-in requests from these subnetworks will be allowed.
The system also provides a blacklist, for blocking rogue log-in attempts.

Email Settings
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Admin Settings

Edit a Collector

Settings

Guidelines

SMTP Server

URL of the SMTP serve from which FortiPortal sends emails

Email From

Email address. Emails sent from FortiPortal will originate from this address.

Port

Email server port. The default value is 25.

Authentication

Enable or Disable

User Authentication
Authentication Access

Set to Local or Remote.
If local, the service provider and customer user log-in credentials are checked in
the local user databases. With the local option, you must add an SP user entry
for each administrative user, and a customer user for each end-customer user.
If remote, the service provider and customer user log-in credentials are checked
in the remote RADIUS server or FortiAuthenticator user database.
NOTE: If you change the authentication configuration from local to
SSO, or from SSO to local, you must reboot the FortiPortal.

Other
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Store Aggregation Data
for

Length of time (in days) that the system will save the aggregation data. Values
include: 30, 60, 90, or 180 days. The default is 30 days.

Store Report Data for

Length of time (in days) that the system will save report data. Values include: 30,
60, 90, 180, or 365 days. The default is 180 days.

Load Balancer
Domain/IP Address

Load balancer IP address or domain name, if you have configured multiple
instances of the Apache Tomcat server.

Load Balancer Port

Load balancer port number (required if you specified a load balancer IP address,
not required for a domain name). The default value is 443.

Max Reports Allowed

Maximum number of reports that can be defined for this customer. This number
includes customer-defined reports and also any reports that the service provider
has defined for this customer.

Alert Email From

Alert emails will be sent from this email address.

Alert Email To

Alert emails will be sent to this email address.

Language

Desired language (default, English)
If you change the language, save the settings and log out. The change takes
effect upon subsequent logins.

TLS/SSL Versions

Select how many TLS/SSL versions are saved on the system.
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Remote Authentication - FortiAuthenticator

Settings

Admin Settings

Guidelines

Remote Log Server
Primary Server

Primary log server IP address

Primary Port

Primary log server port number (mandatory if server address supplied)

Secondary Server

Secondary log server IP address

Secondary Port

Secondary log server port number (mandatory if server address supplied)

Remote Authentication - FortiAuthenticator
When you select Authentication Access: Remote Authentication, the system displays additional settings to
configure.

NOTE: If you change the authentication configuration from local to SSO, or from SSO to local, you must reboot the
FortiPortal.

The following table describes the remote authentication fields:

Settings

Guidelines

Remote Server

Select FortiAuthenticator, RADIUS, SSO

Allow Service Provider
usernames without domain

Enable or Disable. If you enable this field, the user can enter their user ID
without a domain qualifier, and the system will try to authenticate the user
credentials in each of the domains until a match is found.

Remote Server Key

Secret key for REST API requests

Remote Server
IP Address

IP address of the authentication server

Remote Server Port

IP port for the authentication server (default is 443)

Remote Server User
(Forti Authenticator only)

Administrator user name for the authentication server. This user must have
sufficient permission to initiate REST API requests.
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Admin Settings

Settings

RADIUS Server Configuration

Guidelines

Remote Server Key
Domains

The service provider may allow administrative users to be defined in more
than one domain.
Enter a domain, then click the + button. The new domain appears in the list
below the entry box.

If you select RADIUS as the remote server, the system displays an icon beside the Remote Server drop-down
selector. Click this icon to configure the RADIUS roles ("RADIUS Roles" on page 77.

RADIUS Server Configuration
Configure the following in the RADIUS server:

1. Add the following vendor-specific attribute to the Fortinet dictionary file:
VENDOR 12356 Fortinet

2. To configure FortiPortal roles in the RADIUS server, use the following vendor-specific attribute. You can specify
multiple roles by using comma-separated values:
VENDORATTR 12356 Fortinet-Fpc-User-Role 40 string (NOTE: A user will not be able to login to
FortiPortal if the roles are not configured on the RADIUS server.)

3. Specify the customer identification, which is used to map a particular user to a customer profile. The RADIUS
server will send one of the domain names specified in the Domains field of the customer settings, in the value of
the new VSA.
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Admin Settings

VENDORATTR Fortinet-FPC-Tenant-Identification 41 string

Releases 2.2.1 and later:
If the service provider has custom roles defined in the RADIUS server, you can map these to FortiPortal roles by
configuring entries in "RADIUS Roles" on page 77.

Remote Authentication - SSO
If you select SSO as the remote server type, the system displays additional settings to configure:

For SSO, FortiPortal supports Service Provider - initiated or Identity Provider - initiated SAML authentication. The
following table describes the SSO authentication fields:

Settings

Guidelines

Remote Server

SSO

Allow Service Provider
usernames without domain

Enable or Disable. If you enable this field, the user can enter their user ID
without a domain qualifier, and the system will try to authenticate the user
credentials in each of the domains until a match is found.

SSO IDP Entity URL

IDP Entity URL(ID) for SAML provided by IDP server

IDP sign on service
endpoint URL

Endpoint URL for IDP (Post/Redirect) provided by IDP Server

SSO Application Id

SSO application provided by IDP
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Remote Authentication - SSO

Settings

Guidelines

SSO Audience URL

URL used for audience within assertion (format:
https://<FPC_PORTAL> /fpc/saml/SSO)

Attribute Role

Attribute parameter name that maps to corresponding role in FPC

Tenant Identification Attribute

Introduced with FortiPortal Version 3.2.1, this attribute specifies
a 'string' value that FortiPortal uses under SSO to map a user to a
specific customer.
This feature works similar to the Tenant Identification Attribute in
RADIUS, except that in SSO, FortiPortal allows you to configure
the name of the attribute on the Administration Settings page.
If you configure “My Customer Id” as the attribute value,
FortiPortal expects the following in the authentication response
from the SSO server:
<My Customer Id>Fortinet</My Customer Id>

where Fortinet is the value returned by the SSO server. This
value must have been supplied to the “Domains” field in the
Customer Add/Edit screen.
For a RADIUS server, the Tenant Identification Attribute value is
a Fortinet Vendor Attribute value.The server will send “Fortinet”
in the authentication response.
Please note that FortiPortal treats the attribute values from
either RADIUS or SSO server equally.
IDP logout service endpoint

(Optional) IDP Logout URL provided by IDP

SSO Error URL

(Optional) Error URL provided by IDP

SSO certificate

Certificate provided by IDP used by SP to decrypt the signed
response

Domains

The service provider may allow administrative users to be
defined in more than one domain.
Enter a domain, then click the + button. The new domain
appears in the list below the entry box.

Configure Download

Use the following buttons to set up file download.
l

sp.xml

l

isp.xml

For troubleshooting SSO configuration, FortiPortal provides the following URL for the SPUSER to authenticate
locally (even if the system configured for SSO remote authentication):
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https://<Portal>/fpc/adminuser/login
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RADIUS Roles

Page Actions

RADIUS Roles
Clicking the View Roles (i.e., role mapping) icon adjacent to the Remote Server field on the Settings page
displays the RADIUS Roles page. Here, you can configure the mapping between FortiPortal roles and RADIUS
roles. For each RADIUS role, the page displays the role type (Service Provider or Customer) and a list of
FortiPortal roles that map to the RADIUS role.

Page Actions
The RADIUS Role page contains the following actions:
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l

Add - open a new page with the form to add a RADIUS role (see immediately below)

l

Search - enter text to search for RADIUS role names containing that text
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Per-Role Actions

RADIUS Roles

Per-Role Actions
When you scroll over a entry in the RADIUS role list, the following icons appear in the Action column:
l

Edit - opens a new page with the form to edit an existing RADIUS role (see below)

l

Delete - deletes the selected RADIUS role
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RADIUS Roles

Per-Role Actions

The Add RADIUS role and Edit RADIUS role forms contain the following fields:

Settings

Guidelines

Role Name

Names the RADIUS role. The name must match a role name in the RADIUS
server.

Role Type

Service Provider or Customer

Available FPC Roles:

Lists of available FortiPortal roles
Use the search box to filter the choices available.

Selected FPC Roles

Selects the FortiPortal Roles to associate with this RADIUS role
Use the search box to filter your selected choices.
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Roles

Roles
Clicking Admin>Roles displays role information (type and permissions) for each FortiPortal role:

Page Actions
The Roles page contains the following actions:
l

Add - open a new page with the form to add a role

l

Search - enter text to search for role names containing that text

Per-Role Actions
When you scroll over a entry in the roles list, the following icons appear in the Action column:
l

Edit - opens a new page with the form to edit an existing role

l

Delete - deletes the selected role
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Roles

Per-Role Actions

Clicking the + Add button displays the Add Role form which contains the following fields (clicking the Edit
Settings icon under Actions displays an identical form with the fields entered):

Settings

Guidelines

Role Name

Name for the role, which must be unique for this customer

Role Type

Service Provider or Customer

Available Permissions:

List of available FortiPortal Permissions
Use the search box to filter the choices available.

Selected Permissions

FortiPortal Permissions to associate with this role
Use the search box to filter your selected choices.
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System Log
Clicking Admin>System Log displays a page where you can monitor and download a set of system logs:

Page Actions
l

Start - starts to display the system logs

l

Stop - stops the system logs

l

Download - exports the captured system logs in a file

Initial Log-Aggregation Delay
After FortiPortal starts to receive the logs, there may be a delay of up to 15 minutes before the aggregated data
appears on the dashboard.
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Theme

Custom Theme Options

Theme
FortiPortal provides a default UI theme that is applied to the Administrative Web Interface and the Customer
Portal Interface. The Theme page provides configuration fields that allow you to customize this theme.
Configuration changes apply to both user interfaces (Administrative and Customer portal).

Custom Theme Options
You can configure customizations such as:
l

Select a predefined color scheme.

l

Create a custom color scheme.

l

Define custom URLs and text fields.
l
URLs such as contact information and privacy policy.
l

l

Custom text for your company name, service name and service description.

Upload custom images.
l
images for the log-in page and page banner

All of the custom fields are optional. Blank fields will be ignored.

Select a Predefined Color Scheme
From the Color Scheme panel of the Theme tab, select one of the predefined schemes. This scheme takes
effect when you click the Save button.

Create a Custom Color Scheme
Define a custom color scheme by selecting colors in a Color Picker or by changing the FortiPortal CSS file.
Although you can switch between the two methods, these systems are independent. For example, changes made
in Color Picker do not modify the colors in the CSS file.
The following figure shows the Color Scheme panel once you select to customize a scheme:
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Theme

Using the Color Picker
To use the color picker to create a custom color scheme, select custom in the Color Scheme selector, and click
the green Color Picker icon. This opens the Add Custom Color Scheme form.

The form is divided into the following sections:
l

l

l

l

Global Settings
l
Select the Font Family to use for all text on the site.
Background Color Settings
l
Select the colors for various page elements.
Font/Text Color Settings
l
Select the text colors for various text fields.
Chart Series Color Settings
l
Color selection for each slice in a pie chart.

Changes take effect when the theme is saved successfully.
The following figure shows the page elements that have custom background colors and text colors (see the table
below for descriptions of the callouts):
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Theme

Create a Custom Color Scheme

Descriptions of the callout labels in the figure above:
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Callout

Label

Description

1

Page

Background and text color for the overall page, excluding the
header and footer

2

Page Header

Background and text color for the top portion of the page,
including the tabs

3

Page Footer

Background and text color for the bottom portion of the page

4

Button

Background and text color for the buttons on the page

5

Widget header

Background and text color for the widgets on the dashboard,
and for tables on the other pages
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Theme

Chart Series Color Settings
Chart Series Color Settings refer to pie charts and bar charts on the dashboard page (see the table below for
descriptions of the callout labels):

Descriptions of the callout labels in the figure above:

Settings

Callout

Impacted Chart Segment

Series #1

1

First

Series #2

2

Second

Series #3

3

Third

Series #4

4

Fourth

Series #5

5

Fifth

Series #6
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Using Custom CSS File
Select custom in the Color Scheme selector, and click the Upload CSS button.

To update the CSS file, follow these steps:

1. Click Export to export the current CSS file. The file is saved in the Downloads folder of your local machine.
2. Edit the file to make changes as desired and save the file.
3. Click Import.
4. Use the file chooser to select your updated CSS file.
If the imported file contains any invalid CSS style, the style will be reset to the default CSS style.

Custom URLs and Text
The following figure displays the URL Settings panel.

The URL Settings panel sets URL and text fields for the login page. The maximum length of each custom text
field is 100 characters.
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The locations of the fields are shown in the following figure (see the table below for descriptions of the callout
labels):

Descriptions of the callout labels in the figure above:

Settings

Callout

What does it Display?

Company Name

1

Company name and header logo on the header of every page

Service Name

2

Service name and service logo image at the top of the login page

Service Login Footer

3

Service login footer at the bottom of the login page. (NOTE: The
login page does not include a separate footer color.)
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Custom Images
The following figure shows the Images panel:

Some of the custom image fields refer to the login page. The locations of the fields are shown in the following
figure (see the table below for descriptions of the callout labels):

Descriptions of the callout labels in the figure above:
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Settings

Callout

Header Logo Image

4

Service Logo Image

5

Description
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Resizing Images
When you upload an image for one of the custom fields, the system displays a thumbnail of the image. If the
uploaded image is too large, you can drag from the right edge and bottom edge of the image to resize it. You can
also drag from the bottom right corner (or depress the shift key), to retain the current proportions of the image as
it changes size.
For assistance in resizing the image, the system provides a sizing box, and also provides the image height and
width.
The help (?) icon for each image field provides the minimum and maximum dimensions for each image.
The following figure shows a downloaded alert icon image before resizing and after resizing:

Before resizing

After resizing

Details of the Theme Configuration Fields
The following table describes the configuration fields:

Settings

Guidelines

Default value

Color Scheme

Select a color scheme for the Admin pages.
Click the Color Picker icon to add (that is, edit) a custom
color scheme.

Blue

Type

Visible for a custom scheme. Select Color Picker or
Upload CSS.

Color Picker
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Settings

Guidelines

Default value

Color Picker

Visible only when you select Color Picker as the color
scheme type.
Opens the Edit Custom Color Scheme form. See the
"Using Color Picker" section for details.

n/a

CSS File

Visible when you select Upload CSS as the color scheme
type. Displays buttons to export or import a CSS file.

n/a

Export

Exports the current CSS file. The file is saved in the
Downloads folder of your local machine.

n/a

Import

Imports a file that replaces the current CSS file in use.
Opens a file-chooser dialog allowing you to select a CSS
file.

n/a

URL values for Header and Footer
There are links in the header and footer to various corporate web pages. The following URL values must be
public web pages. Specify the full URL, including "http://".
Company Name

(manadatory field) Service Provider company name is
displayed in the footer of each page.

n/a

Service Name

Service name to display on the login page

Service Login Footer

Footer text to display on the login page

Header URL

Link activated from the company logo in the header, and
the company name in the footer. Specify the URL to open,
such as your company home page.

blank

Contact URL

Footer contains a link to the Contact page. Specify the
target URL.

blank

Legal URL

Footer contains a link to the Legal page. Specify the target
URL.

blank

Privacy URL

Footer contains a link to the Privacy page. Specify the
target URL.

blank

Acceptable Use Policy
URL

Footer contains a link to the Acceptable Use Policy page

blank

Image files
Unless otherwise stated, the supported file types for
images include jpg, png, and gif.
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Settings

Guidelines

Default value

Favicon Image

(Uploaded) Image file that FortiPortal will use as a
Favorites icon.
Supported file types include ico, jpg, png, and gif.
The recommended file type is .ico and the maximum
image size is 20x20 pixels.

blank

Header Logo Image

Image file that FortiPortal will use for the header logo.
The recommended image size is 144x48 pixels.

blank

PDF Logo Image

Image file that FortiPortal will use as the logo in
PDF reports.
The recommended image size is 144x48 pixels.

blank

Service Logo Image

Image file that FortiPortal will use as the logo on the login
page.
The recommended image size is 104x80 pixels.

Icons in the
page banner

1. Alert Image

Image file for the altert icon in the page banner.
The recommended image size is 30x30 pixels.

2. Customer Count
Image

Image file for the customer icon in the page banner.
The recommended image size is 30x30 pixels.

3. Users Image

Image file for the MSSP users icon in the page banner.
The recommended image size is 30x30 pixels.

4. Change Password
Image

Image file for the change password icon in the page
banner.
The recommended image size is 30x30 pixels.
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System Info
Click Admin>System Info to display additional information about the system.

System Info page

The page displays the following panels:
l

License Information

l

Version Information

l

Certificate Information

License Information
This panel provides information about the FortiPortal license and enables you to upload a new license:

93

Field

Description

VM License

Indicates the type of license and whether the license is valid

Number of Devices
Allowed [Used]

Number of devices to be managed that are included in the license (number in
brackets indicates the number of devices currently used)

Number of FAP Devices
Allowed [Used]

Number of Fortinet AP devices that are included in the license (number in
brackets indicates the number of devices currently used)

FSA Devices Used

Number of Fortinet Sandbox devices that are in use

Expiry Date

Expiry date of the license
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Upload License
Use the following steps to upload the FortiPortal license:

1. Navigate to Admin > System Info, and locate the License Information panel.
2. Under the Upload License label, click the Browse... button.
The system opens a file chooser window.
3. Choose a license file and click Open.
4. The system automatically restarts the FortiPortal VM, to apply the license.

Version Information
The Version Information panel displays the FortiPortal version and the build number.

Certificate Information
The Certificate Information panel displays the certificate file name and private key file name.
From this panel, you can select and upload a new certificate and private key for the FortiPortal (using PKCS#8
format).
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Page Actions

Trusted Hosts
If you enable Trusted Hosts as a global setting (see Admin Settings), the system enforces a configurable blocklist
and whitelist for all admin and customer users. The Trusted Hosts displays the blocklist. Refer to Administrative
Users for information about creating the Trusted Hosts whitelist.
Clicking Admin>Trusted Hosts displays the IP BlockList where you can create and edit blocklist entries.

Page Actions
The Roles page contains the following actions:
l

+ Add - open a new page with the form to add a blocklist entry

l

Search - enter text to search for roles containing that text

Per-Role Actions
When you scroll over a entry in the roles list, the following icons appear in the Action column:
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l

Edit - opens a new page with the form to edit a Trusted Host

l

Delete - deletes the Trusted Host
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The following figure shows the Add Trusted Host form:

The Add/Edit Trusted Host forms contain the following fields:

Settings

Guidelines

IPv4
IP Start

Start address for the range covered by this entry

Mask

Defines the range of IP addresses covered by this entry

IPv6
IP Start

Start address for the range covered by this entry

:Prefix

Defines the range of IP addresses covered by this entry
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Additional Resources
Clicking Admin>Additional Resources displays a the button (resource) list, which enables admins to add, edit,
delete, or view the displayed resources:

Page Actions
The Button List page contains the following actions:
l

+ Add - open a new page to add a resource

l

Search - enter text to search for resources containing that text

Clicking the + Add button opens the Add Button window:
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Enter the following button details:

Field

Description

Name

Button or resource name

URL

Link to open when button is clicked

Status

Active or Disabled

Image

Default image is pre-populated. You can change or resize it with the Browse
button and resize icon.

Per-Role Actions
When you hover over a button row, the following icons appear in the Action column:
l

Edit - opens a new page with the form to edit an existing role

l

Delete - deletes the selected role

Clicking the Edit button displays the Edit Button: button form, where button can be Chat, FAQ, or Help:

At any time, you can click the Delete icon to remove the button row:
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Audit
The Audit tab displays an log of user activity on the Administrative Web Interface:

Page Actions
l

Audit Log List - set the duration of the logs to display (last 60 minutes, last 1 day, last 7 days, or customize)

l

Search - use any column to search the audit log list by level, user name, event type, client IP address, or message

l

Export to CSV - export the audit log list as a Comma-Separated Value (CSV) file

Per-Audit Actions
When you click the Message field for an Edit Customer audit entry, the system opens a pop-up window to
display the details of the change. The details window shows the original ("oldDetails") and new ("newDetails")
field values:
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Per-Audit Actions

FortiPortal 4.1.0 Release Notes
Fortinet Inc.

Per-Audit Actions

Upgrading FortiPortal Software

Upgrading FortiPortal Software
This chapter provides instructions to upgrade FortiPortal from an earlier version to a more recent version.
To upgrade from version 4.0.0 or later, you can upgrade directly to version 4.1.0.
To upgrade from version 3.2.2 or earlier, you must:

1. Perform a sequential set of upgrades to version 4.0.0.
2. Upgrade from version 4.0.0 to version 4.1.0.
If you are upgrading from a version prior to version 4.0.0, refer to Table 1 on page 102 to determine your upgrade
path. Find your existing version in the Existing Version column of the table and determine the more recent
version(s) to which you can upgrade in the Compatible Upgrade Version column. When you upgrade to a more
recent version, repeat this process until you're running the most recent version.

Table 1: Upgrade Path
Existing Version

Compatible Upgrade Version

2.1.0

2.1.1

2.1.1

2.2.0

2.2.0

2.2.1, 2.2.2, 2.3.0

2.2.1

2.2.2, 2.3.0

2.2.2

2.3.0

2.3.0

2.3.1

2.3.1

2.4.0, 2.4.1

2.4.0

2.4.1, 2.5.0, 3.0.0

2.4.1

2.5.0, 2.5.1, 3.0.0, 3.1.0

2.5.0

2.5.1, 3.0.0, 3.1.0

2.5.1

3.0.0, 3.1.0, 3.1.1, 3.1.2

3.0.0

3.1.0, 3.1.1, 3.1.2

3.1.0

3.1.1, 3.1.2, 3.2.0

3.1.1

3.1.2, 3.2.0

3.1.2

3.2.0, 3.2.1, 3.2.2
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Existing Version

Compatible Upgrade Version

3.2.0

3.2.1, 3.2.2, 4.0.0

3.2.1

3.2.2, 4.0.0, 4.0.1

3.2.2

4.0.0, 4.0.1, 4.0.2, 4.0.3

4.0.0

4.1.0

4.0.1

4.1.0

4.0.2

4.1.0

4.0.3

4.1.0

4.0.4

4.1.0

Upgrade procedures

Upgrade procedures
Complete the following tasks to perform an upgrade:

1. From the Fortinet Customer Service & Support website (https://support.fortinet.com/), download the Portal
and/or Collector build files (the .out files, not the .ovf.zip files) for the version to which you want to
upgrade.
2. Perform a backup of the Portal and Collector MySQL database(s). For details, see "Perform a backup" on
page 103.
3. To prevent the Collectors from processing logs during the upgrade, shut down the Collectors from the VM
console.
4. Restart the Portal. From the VM console, log in as admin and type execute reboot.
5. Upgrade the Portal. For details, see "Upgrade the Portal" on page 104.
6. Turn on the Collector(s). For example, from the vSphere client, right-click the Collector(s) and go to Power
> Power On.
7. Upgrade the Collector(s). For details, see "Upgrade the Collector " on page 104
Do not turn off or restart the Portal or Collector(s) while upgrading. Doing so can cause
a loss of data and otherwise harm the system.

Perform a backup
1. You can export (or create a snapshot of) a VM for a backup. For example, for VMware, from the vSphere
client, shut down the database VMs from the VM console. If you are using the sample MySQL database, log
in as user fpc, get root privileges, type sudo su, and type shutdown now.
2. For VMware users, go to File > Export > Export OVF Template to export the VM.
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3. For Name, set a name for the backup.
4. For Directory, select a directory from which you can restore the backup to vSphere.
5. Optionally, enter a Description for the backup.
6. Click OK.
7. Once the backup is complete, right-click the virtual machine you backed up and go to Power > Power On.

Upgrade the Portal
1. Log in to the Portal using a service provider (administrator) account.
2. Select the Admin tab.
3. Click the FPC Admin button to open the administrator portal. The administrator portal opens in a new
browser tab.
4. Log in to the administrator portal. The default user name is admin, and there is no default password.
5. Select the System Settings tab.
6. In the System Information widget, click the Update button beside the Firmware Version.
7. In the pop-up dialog, click Choose File and select the Portal .out file that you downloaded in Step 1 in
"Upgrade procedures" on page 103.
8. Click OK. The Portal will upgrade. After the firmware is upgraded, the system will restart automatically.
NOTE: If you have a RADIUS server configured in an existing version, you must re-enter the RADIUS attributes
once the Portal upgrade is complete. For details, see the FortiPortal Administration Guide:

http://docs.fortinet.com/fpc/admin-guides

Upgrade the Collector
For a Collector HA cluster, first upgrade the master and then the slave(s). Repeat these steps for each Collector:

1. Restart each collector, one at a time.
2. Log in to the Portal using a service provider (administrator) account.
3. Select the Admin tab.
4. Select the FPC Collectors tab.
5. Click the IP address of the Collector to open that Collector's administrator portal. The administrator portal
opens in a new browser tab.
6. Log in to the administrator portal. The default user name is admin, and there is no default password.
7. Go to System Settings.
8. In the System Information widget, click the Update button beside the Firmware Version.
9. In the pop-up dialog, click Choose File and select the Collector .out file that you downloaded in Step 1 in
"Upgrade procedures" on page 103.
10. Click OK. The Collector will upgrade. After the firmware is upgraded, the system will restart automatically.
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Alert Messages
FortiPortal generates the following alert messages. The Service Provider level messages include the name of the
customer (XXXX in the list below).

Service-Provider Level Messages:
Total Storage reached 90 % for customer(XXXX)
Collector Storage reached 90 % for customer(XXXX)
FPC Storage reached 90 % for customer(XXXX)
Email server credentials are invalid
Failed to send the report
Please make sure all device assign to customer(XXXX) on same collector.
Wifi: Unassigned FAP(s):(XXXX)
Cannot connect to the database: URL Name
Delete data process for Customer(XXXX) Started
Delete data process for Customer(XXXX) ended
Delete data process for Site(XXXX) Started
Delete data process for Site(XXXX) ended
Delete data process for unassigned device(XXXX) Started
Delete data process for unassigned device(XXXX) ended
Delete data process for wifi network(XXXX) Started
Delete data process for wifi network(XXXX) ended
Unable to connect <Fpc Database> : XXXX
Unable to connect <Collector Database>: XXXXX
Unable to connect <Collector>: XXXX
Unable to connect <FortiManager> : XXXX
Failed to poll Fortimanager: XXXX
Wrong remote user authentication settings : XXXX
Collector cleanup alert messages : XXXX
Cleanup for collector storage : customer <Customer Id>
Settings are successfully saved. For authentication related changes please reboot system.
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Customer-Level Messages:
Total Storage reached 90 %, contact your service provider
Storage reached 90 %, contact your service provider
FPC Storage reached 90 %, contact your service provider
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Appendix: Installation Using OpenStack
The FortiPortal software runs on virtual machines. Each VM runs either the Portal or the Collector software.
You can use OpenStack to create and manage the VM instances.

Prerequisites
Note the following prerequisite items:

1. You must provide a MySQL server for the Portal DB, and one or more MySQL servers for the Collector DB
instances.
2. Download the Portal and Collector images from Fortinet Support site.
3. Access to OpenStack Horizon Dashboard for your OpenStack environment.

Downloading FortiPortal Image Files
To download the required image files.

1. Navigate to the Fortinet customer service page (https://support.fortinet.com).
2. Download > Firmware Images.
3. In Firmware Images page, select FortiPortal.
4. Download the latest image files (one portal file, one collector file) in QCOW2 format:
l
fpcvm64imageCollector.out.qcow2
l

ffpcvm64imagePortal.out.qcow2

OpenStack Horizon Dashboard
Log in to the OpenStack Horizon Dashboard, which provides a web-based user interface to OpenStack services.

Create Images for the Portal and Collectors
Create a portal image and a collector image.
Use the following steps to create an image:

1. From the left menu, select Compute>Images.
2. Click Create Image .
3. System opens a form. Enter the following fields in the form:
a. Enter a unique name for the image.
b. Image Source: select Image File.
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c. Click Choose File to open the file chooser.
d. Select the Portal or Collector file that you saved on the hard drive.
e. Format: QCOW2.
f. Architecture: leave blank.
g. Minimum Disk: 80.
h. Minimum Ram: 16.
i. Click Create Image.

Create Volumes for the Portal and Collector
Create a storage volume for the portal and the collector.
Use the following steps to create a volume:

1. Click Volumes in the main menu.
2. Click the Create Volume button.
3. System opens a form. Enter the following fields in the form:
a. Enter a unique name for the volume.
b. Volume Source: No source, empty volume.
c. Type: No volume type.
d. Size: 80.
e. Availability Zone: select a zone.
f. Click Create Volume.

Launch the Instances
Launch one instance for the portal, and one for the collector.
To launch a VM instance:

1. Click Instances in the main menu.
2. Click the Launch Instance button.
3. System opens a form. Enter the following fields in the Details tab of the form:
a. Availability Zone: select a zone.
b. Instance Name Enter a unique name for the instance.
c. Flavor: Select the appropriate size of VM.
d. Instance Count: You can create one or more instances.
e. Instance Boot Source: Select Boot from image.
f. Image Name: Select the image name.
4. In the Access & Security tab:
a. Key Pair: Select a key pair.
b. Security Groups: Select the default.
5. In the Networking tab:
a. Available networks: Select a network.
6. Click Launch.
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Assign a Floating IP Address

Launch one instance for the portal, and one for the collector.

Assign a Floating IP Address
To associate an IP address to the instance:

1. Click Instances in the main menu.
2. In the Actions column, select Associate Floating IP in the pull-down list.
3. Click the + key to obtain an available IP address.
4. Click Associate.
Note the Floating IP address value. You will need this to configure the IP interface.

Associate Volume to the Instances
To associate the storage volume to the instance:

1. Click Volumes in the main menu.
2. In the Actions column of the new volume, select Manage Attachments in the pull-down list.
3. Select the instance to associate.
4. Click Attach Volume.

Reboot the Instances
To reboot the instance:

1. In the Action column, select Hard Reboot in the pull-down list.

Determine the IP Address and Port Number
After the reboot, use the FortiPortal CLI to determine the IP address and external port number for each instance:

1. Click Instances in the main menu.
2. Note the instance internal IP address.
3. Click the instance name. The system displays the instance overview.
4. Click the Console tab.
5. Log in using default credentials.
6. Run the interface configuration command, and note the ethernet port number:
exe shell
ifconfig
exit
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Configure Portal Parameters
After the reboot, use the FortiPortal CLI to configure the Portal Parameters. Configure the parameters using the
following steps:

1. Open the OpenStack console tab to view the console for the Portal.
2. Log in using the default user ID (admin, with no password required).
3. Use the CLI instructions (see the steps below) to set the following parameters:
Setting

Description

Hostname

Host name for the Portal VM

IP address and
Default Gateway

Floating IP address for the Portal VM and the route to the default gateway

SQL settings

Floating IP Address of the Portal SQL server, database name, user
credentials.

NTP settings

IP Address of the NTP server

Note: For the portal VM and SQL server, use the Floating IP addresses created in the step: Assign a Floating IP
Address
CLI steps
1. Configure host name for the Portal VM:
config system global
set hostname <host name>
end

2. Configure system IP address and default gateway for the Portal VM:
config system interface
edit <port number>
set ip <IP address> <mask>
set allowaccess ping https http ssh snmp telnet
end
config system route
edit 1
set device <port number>
set gateway <default gateway>
next
end

3. Configure SQL settings:
config system sql
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set
set
set
set
set
set

Configure Collector Parameters

status remote
database-type mysql
database-name fp_fazlite
username <portal db mySQL username>
password <portal db mySQL password>
server <IP address for portal db>

end

4. Configure NTP settings for the Portal VM:
config system ntp
config ntpserver
edit 1
set server <ntp server>
end
set status enable
end

5. Reboot the VM.

Configure Collector Parameters
After the reboot, use the FortiPortal CLI to configure the Collector Parameters. Configure the parameters using
the following steps:

1. Open the OpenStack console tab to view the console for the collector.
2. Log in using the default user ID (admin, with no password required).
3. Use the CLI instructions (see the steps below) to set the following parameters:
Setting

Description

Hostname

Host name for the Collector VM

IP address and
Default Gateway

Floating IP address for the Collector VM and the route to the default
gateway

SQL settings

IP Address of the Portal SQL server, database name, user credentials.

NTP settings

IP Address of the NTP server

NOTE: Always enter the database information for the Portal DB, even when you are configuring a Collector VM.

CLI steps
1. Configure host name for the Collector VM:
config system global
set hostname <host name>
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end

2. Configure system IP address and default gateway for the Collector VM:
config system interface
edit <port number>
set ip <IP address> <mask>
set allowaccess ping https http ssh snmp telnet
end
config system route
edit 1
set device <port number>
set gateway <default gateway>
next
end

3. Configure SQL settings:
config
set
set
set
set
set
set
end

system sql
status remote
database-type mysql
database-name <db name>
username <portal db mySQL username>
password <portal db mySQL password>
server <IP address for portal db>

4. Configure NTP settings for the Collector VM:
config system ntp
config ntpserver
edit 1
set server <ntp server>
end
set status enable
end

5. Reboot the VM.

Updating SSL Certificate File
Use the following steps to import an SSL certificate for the FortiPortal VM.
From the Admin portal, click Admin>System Info to display information about the SSL certificate.
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Installing MySQL for FortiPortal Databases

System Info page

The Certificate Information panel displays the certificate file name and private key file name.
From this panel, you can select and upload a new certificate and private key for the FortiPortal (using the PKCS#8
format).

Installing MySQL for FortiPortal Databases
The MySQL database server for the Portal or Collector is a standard physical or virtual server.
Edit the my.cnf file to adapt the mySQL configuration for FortiPortal:

1. Edit the bind address to make the database reachable from the FortiPortal:
bind-address = <IP address of the database server>
2. We recommend that you create a dedicated MySQL user for FortiPortal. You will need to know the credentials for
this user when you create the portal.

Notes:
l

l

l

The portal database bind-address should match the SQL server address that you configure in the SQL settings of
the portal (see Configure Portal Parameters).
The collector database bind-address should match the SQL server address that you configure when you add a
collector. See FortiPortal Collectors.
If you are using MYSQL 5.7.x, please add the following lines in the my.cnf file:
l

[mysqld] sql_mode = STRICT_TRANS_TABLES,NO_ZERO_IN_DATE,NO_ZERO_DATE,ERROR_FOR_
DIVISION_BY_ZERO,NO_AUTO_CREATE_USER,NO_ENGINE_SUBSTITUTION

Reconfiguring MySQL Password on FortiPortal
If you change the password for the FortiPortal user in the portal MySQL database, you need to update the
configuration in the portal and collector:
config system sql
set status remote
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Reconfiguring MySQL Password on FortiPortal

Appendix: Installation Using OpenStack

set database-type mysql
set password <portal db mySQL password>
end
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